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1 Introduction

Contacts Manager for Lync is a new tool specially designed to ease and simplify the task of
contacts management centrally and automatically, specifically: creating and maintaining
contact lists, adding/removing contacts, and updating contacts and contact lists for your entire
network. With Contacts Manager for Lync, your organization will save time and money as well
as boost efficiency.

1.1 Overview

Contacts Manager for Lync is a reliable 3rd party solution designed to ease the process of
contact management for Lync. It is aimed at provisioning the process of creating, maintaining,
adding/removing, populating, and updating pre-set contact lists for all the users at once.
Managing contacts couldn't be easier, that means saving considerable amounts of time and
efforts, while increasing the productivity for your IT administrators at a notable rate.

1.2 Solution

Contacts Manager is a cost effective solution that helps IT and System Admins manage the
company contact lists throughout the organization and, its branches all over the world. Now,
there is no need to use power scripts or other means that require an increase in IT involvement.

1.3 Features

* Manage contacts and groups for all users from any endpoint in the company at the
same time.

» Edit and manage contact Lists for some or all users.

= Create multi-contact lists for the company.

= (Create up to 64 distribution groups in any contact List.

» Populate custom contact List.

» Populate contact List for a specific user.

=  Copy any group from contact list to any other contact list.

» (reate, save and restore a backup for contact Lists.

= Push a contact list to all/some users.

» Build multiple contact lists and populate/push to a different groups of users.

» Add and remove images for any user.

= Enable/disable any to any pool when running multi-pools.

=  Multiple select and add users from active directory to a contact list.

*  Wipe a contact for any user.

= View a user’s current contact list.
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» Wipe a contact from all assigned users.

= Search a contact list for a specific group.

» Search a group for a specific contact.

= Populate a contact list for specific user.

» Any contact list can contain two types of groups (normal groups created by Contacts
Manager and distribution groups from the active directory).

= Any user of Contacts Manager can specify whether to display images in Contacts
Manager Environment or not.

= Any user of Contacts Manager can create/populate federated SIP contact.

= Any user of contacts Manager can filter users retrieved from active directory by SIP
Address, or Department or UPN or Name or Telephone Number or Manager.

= Any user of contacts Manager can export/import specific contact list.

= Any user of Contacts Manager can enable users to Lync server.

New features of this release:

= (Contacts Manager supports UCS Lync users.

= Contacts Manager supports office 365 Lync users.

» Contacts Manager supports create/populate response groups for all/some users.

» Any user of Contacts Manager can create/populate telephone contact (Not supported
in UCS and office 365).

» Any user of Contacts Manager can export contact list for specific user then import it
then populate it to all/some users.

* Any user of Contacts Manager can rename a populated group no a new name (i.e.
Rename the HR group to Human Resources group).
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2 Using Contacts Manager
2.1 Starting the Application

To start up the application go to the Start Menu and click on "Apps” ® then open the Contacts
Manager or you can simply open it from the desktop icon.

@ Contacts Manager

Contacts Manager Initialization Wizard

User Privilege Current User: TEST \administrator
3
V) Current Forest: test.com
/
- Current Domain: test.com

,"/'\_ Retrieve Pools Pool Version: Lync Server 2013

@ Enter Your License Key

Please enter your license key #
for mere information please visit V t
bittp e Mytru.com y r u

Your Machine Code |ﬂijBKlIwX+3lelaprXnA== |

7~ | Check Contacts Manager

v/ License
Enter Your License Code
Enter your license code here. |
Cancel
| Reset Configuration O Configure Log Send Log Continue || Bxit
Figure 2.1

Contacts Manager Initialization Wizard Window appears as shown in (figure 2.1), Click on the
"Update” button and enter your license code in the License Key Dialog box, then click "OK."
Contacts Manager will proceed to the Initialization Wizard window as follows:
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To reset your configuration clearing saved configuration data that contain contact lists, click on
"reset configuration” button, (figure 2.2).

Contacts Manager Initialization Wizard

User Privilege Current User: TEST \administrator
Current Forest: test.com
Current Domain: test.com

(-;\ Retrieve Pools Pool Version: Lync Server 2013
)

- lync.test.com

%, |Check Contacts Manager Commercial License
"’_/ License This is a valid License for Lync Server 2013
- Licensed To Company Name: Mohamed Rifaat | User Name:
Maximum Contacts Per User 500 Contacts | Maximum Number Of Contact Lists=5 Lists
Reset Configuration O Configure Log Send Log Continue Exit

Figure 2.2

Note: In the occurrence of a technical issue, we have added an option through which you can
send the log file of your current working state to the Contacts Manager Support Team so; we
can easily recognize your issue. Click on “Send Log” (Figure 2.2) then, attach and send it to
the support@vytru.com.

You are able to determine to load or unload images of users, and groups from the active
directory. Simply check or uncheck the checkbox “Load Pictures for users & Contacts” from the
active directory” (figure 2.3).
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Contacts Manager Initialization Wizard

User Privilege Current User: TEST\administratar
Current Forest: test.com
Current Domain: test.com

@ Retrieve Pools

Check Contacts Manager Commercial License
@ License This is & valid License for Lync Server 2013
Licensed To Company Name: Mohamed Rifaat | User Name:
Maximum Contacts Per User500 Contacts | Maximum Number OF Contact Lists=5 Lists

| Update | Reset Configuration |[¥]

Configure Log | | Send Log | | Continue || &t |

Figure 2.3

To show to the Contacts Manager main window you need to click Continue (figure 2.4)

Contacts Manager Initialization Wizard

Current Forest: test.com
Current Domain: test.com

@ User Privilege Current User: TEST\administrator

@ Retrieve Pools Pool Version: Lync Server 2013

- lync.test.com

Check Contacts Manager Commercial License
License This is a valid License for Lync Server 2013
Licensed To Company Name: Mohamed Rifaat | User Name:
Maximum Contacts Per User500 Contacts | Maximum Mumber OF Contact Lists =5 Lists

| Update | Reset Configuration | Configure Log | | Sendlog | [Continue | Bat |

Figure 2.4
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@ Contacts Manager - O B
ﬁ File Action View Favorites Window Help ||T||?||?|
e zE

] Console Root
.
[ D All Contact Lists
4[4l Active Directory Domains

i @ Contacts Manager Support

Mame

[Z3AN Contact Lists
il Active Directory Domains
@ Contacts Manager Support

Actions

| Contacts Manager 4
Wiew »
MNew Window from Here

|G Refresh

|5 Export List...

Help

Contacts Manager Main wind

ow figure 2.5

10
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3 Using Active Directory

3.1 Displaying Contacts from the Active Directory

To be able to fill the lists and the groups with the contacts, you will have to load all contacts
from the active directory, click on the active directory domains in the left menu, all domains at
your company will be loaded then choose the domain that you want to add the contacts from
(Figure 10.1).

& Contacts Manager - B
& File Action View Favorites Window Help = [=]=]
e« #E = d

[ Console Root testcom LDAP://DC=test,DC=com 318 user | Filter Status: All Enabled Active Directory Users || [P

4 & Contacts Manager

[ Pool N Department Ma * || test.col -
4 [ All Contact Lists ome c2llEs epartment a | & m
4 (=] Contact List1 £ Anamaria lync.test.com FIN Filter By »
4 T2 Contact List £) Angelia lyne test.com Testing View N
3 Management £ Angila lync.test.com Design
3 Sales £ Annelle lync test.com Design New Window from Here
B Assigned Users £ Ardelia Iyne test.com Design |G Refresh
4 [l Active Directory Domains £) Arlinda lync.test.com FIN 5 Export List..

£/ Amoldo lync.test.com Support
EH Hep

£ Audria Iyne.test.com Design
£) Audrie lync.test.com Design

£ Autumn lync.test.com Testing

so e e RERRLIES | ) Avery Iyne.test.com HR
» @ Contacts Manager Support

£)Bari lync.test.com Design

£/Bema lync.test.com FIN

£) Bernarda Iyne.test.com FIN

£ Bemita Iync.test.com T

£/Beuls lync.test.com Design

£ Carman Iyne.test.com T

£ Cassaundra lync.test.com FIN

£ Cassondra lync.test.com FIN

£ Cathern Iyne.test.com FIN

£ Cathleen Iync.test.com Testing

£ Celina lync.test.com Managment

£ Chan Iyne.test.com FIN .
< > :"L—fr” Pt o >

Figure 10.1
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3.2 Filtering Active Directory

To filter active directory query results by; all, name, department, manager, SIP and UPN; right-
click on any domain, choose “Filter By” and choose any filter type (Figure 19.1).

& Contacts Manager
& File Action View Faverites Window Help

(] Console Root user | Filter Status: All Enabled Active D
‘ fg";;“; Manager : Pool Name Department
4 =) Contact List! £ lync.test.com
4 E= Contact List &) Administratos lync.test.com
23 Management '£) Adolph lync.test.com HR
2 Sales ‘£ Adrianna Iync.test.com T
B} Assigned Users '£) Albert Iynctest.com FIN ]
a [l Active Directory Domains ‘£ Aleta Iyncitest.com T S
= b
D Il FierBy > All ;zsign
(: et View » Name Design
o MewWindow from Here Department 'T
e Manager FIN
i @ Contacts Refresh - Testing
Export List... — Design
Design
Help Telephane Number Design
'£0 Arlinda Iyncitest.com FIN
‘£ Amoldo lynctest.com Suppert
‘£ Audria Iync.test.com Design
'£) Audrie Iync.test.com Design
ifJ Autumn lync.test.com Testing
£ Avery Iyncitest.com HR
£ Bari lynctest.com Design
'£)Bema lync.test.com FIN .
< > :‘l"--—--d— fmntees - - >

Filter by Name

Figure 19.1

3.3 Adding Images

To add an image for a user, right-click on a contact then select “Image” then “Add Image”,
browse to add an image of your choice (Figure 20.1).

& File
-

View

tes Window Help

[ Console Reot [Act
“ ?S’ﬁf?ﬂ:‘;xi;s Name Pool Name Department Ma ~ || tes
4 [ Contact List1 L Iync.test.com
s T Contact List £/ Administrator Iync.test.com
@ Management £0 Adolph Iyne.test.com HR
% Sales £ Adrianna Iync.test.com T
@ Assigned Users £ Albert lyne.test.com FIN =]
4 (48 Active Directory Domains £ mleta Ilync.test.com T =
A test.com £ Alexis Iyne.test.com HR —
& me o ot o | D Allyn Iync.test.com Design
£ o £ Alona Iync.test.com Design Alt
“ . S PR ij Add user to contact list » @
£ s : £ Ana FIN
. @ Contacts Manager Support & Ang Assign user to contact list * | Testing @
£oang|  Image » | Addimage Il
:j ::‘ Disable for communication server L s T I %
£ A Show Contact List FIN s
£ Am Support (<)
£ Aud EEDESE Design
£ Aud Help Design
£ Aut Testing
£ mvery Ilync.test.com HR
£ Bari Iynec.test.com Design
£ Berna Iync.test.com FIN .
< >|| < T oo o >

Add image

Figure 20.1
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3.4 Removing Images

To remove an image for a user, right-click on a contact then select “Image” then “Remove
Image” (Figure 21.7).

B Contacts Manager - B -
@ File Action View Favorites Window Help [=l=]x]

| Consale Root
4 ¥ Contacts Manager

Actions

N Pool N Department Ma " -
4 1 All Contact Lists ‘ama ool Name epartmen a test.com
4 [ Contact List1 & lync.test.com Filter By >
4 B ContactList '€ Administrator lync.test.com View N
3 Management ‘£ Adolph lyne.test.com HR
3 Sales '£) Adrianna ync.test.com s New Window from Here
B Assigned Users ‘£ Albert lync.test.com FIN @] Refresh
4 [l Active Directory Domains ‘£ Aleta lync.test.com m (& Export List..
[ testcom £ Mlexis lync.test.com HR
- e - - . . H Hep
£ ceq e i mmiers "l | ') Allyn lync.test.com Design
Ao ‘£ Alona lync.test.com Design Altagracia -
.- ’ Altagrocia_____fync
‘N A'“ 2 DL | Add user to contact list » & Add userto contact list »
- =77 || 'g) Anamaria lyne.te
b @ Contacts Manager Support £ Angeliz e Assign user to contact list ’ &9 Assign userto contact list 3
‘£ Angila ncts|  Image v Add image 4
U Annelle Iyt |
£ v Disable for communication server ‘ Rl nmunication server
‘£ Ardelia ynct g
- T Show Contact Li
&) Alinda ync.t Show Contact List ‘
') Amoldo lync.t |G Refresh
. Refresh
‘&) Audria Iync.t H Hep
‘£ Audrie lync.te Help
') Autumn lync.testeomT restng:
') Avery lync.test.com HR
‘£ Bari lync.test.com Design
'£)Bemna lyne.test.com FIN .
< > :I T DR >

Image

Figure 21.1

13
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4 Building Content List

4.1 Creating a New Contact List

To create a new contact list, right-click on "All Contact Lists” then select “Create” (figure 3.1).

B Contacts Manager = =
ﬁ File Action View Favorites Window Help EIE"E
% 2FE = d
4 Contacts Manager
‘@W Name Contacts Manager i~
a g | Create | ontact Lists Wiew »
Backup e Directary Damains MNew Window from Here
acts Manager Support
Restore |G Refresh
MNew Window from Here |5 Export List...
Hel
Hel 3 7] P
[ ] 2
< >

Create Mew Contacts List

Figure 3.1

In the Create New Contact List dialog box (Figure 3.2) enter a name for the new contact list
and then click "Create"

14
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Contacts Manager

E File Action View Favorites Window Help

7] Console Root
4 ¥ Contacts Manager
(O3 All Contact Lists
a [l Active Directory Domains
; test.com

s, 2 L usuft

5888

- ‘toom
ontacts Manager Support

0o

" ]

MName

CQAH Contact Lists
&!Adlve Directory Domains
| @ Contacts Manager Support

¥ Create New Contact List

Goas

BEIES

Contacts Manager Actions

Contacts Manager

View

New Window from Here
|0 Refresh

5+ Export List...
ﬂ Help

Figure 3.2

Your have created new contact list successfully and it contains two sub categories: contact list
and assigned user(s) (Figure 3.3).

=]
ﬁ File Action View Favorites Win
L

] Console Root
4 7 Contacts Manager
.
4 [=]| Contact List1
I E= Contact List
B Assigned Users
4 [§ll Active Directory Domains

-
4 test.com
s
A s tanscom

M i oscom

S gzoee Sinsuincom

1> @ Contacts Manager Support

Contacts Manager
dow Help

All Contact Lists

Name

Contact List]

- c N

[=]=]x]

Actions

All Contact Lists

& Create
‘S‘J Backup
‘S‘J Restore
View
New Window from Here

5 Export List...
Help

Figure 3.2

15
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4.2 Creating a

To create a new group in the contact list, right-click on

Group” (Figure 4.7).

New Group

Contacts Manager

File Action View Favorites Window Help
[~ Console Root ntact List
4 /7 Contacts Manager
4 [ All Contact Lists There are no items to show in this view.
a Contact List1
E Contact List
B 2| CreateNew Group
4 [ Active D Export Contact List
T test, |
P mport Contact List
(,_ﬁ ‘-:_4, Search
”o
Ao View »
D -
o New Window from Here
» @ Contact
Refresh
Export List...
Help 3
< >

- oI
[=1=]x]

Actions

Contact List =
% Create New Group

3 Export Contact List

m Import Contact List

A Search

View »
Mew Window from Here

|G| Refresh

|5 Export List...

H Hep 4

new group in Contactlist

Figure 4.1

Contacts Manager

[& File Action View Favorites Window Help

|

= H

a4 #» Contacts Manager
4 [C} All Contact Lists
4 [=] Contact Listl
T2 Contact List
3 Assigned Users
s 4 Active Directory Domains
[ test.com

- b v sftcom
> @ Contacts Manager Support

< >

| Console Root Contact List

There are no items to show in this view.

@ Create New Group

- O

[-[s]x]

Actions

Contact List =
@ Create New Group

@3 Export Contact List

@3 Import Contact List

Group name: ‘Sa\es

S Search
4
1 Here
|
4 Hep 4

Action: In progress...

Figure 4.2

“Contact List” then select “Create New

16
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In “Create New Group” dialog box (Figure 4.2) enter a name for the new group, and then click
IIOKII

You can create Up to 100 groups so you are able to create as much group as you want.
=

Contacts Manager

- O
@ File Action View Favorites Window Help EIE"Z‘
% zEG=8
4 % Contacts Manager R -
4 [ All Contact Lists m Cooiacliz,
4 [ Contact List! Sales @ Creste New Group
. B3 Contact List @3 Export Contact List
9 sales 4 Import Contact List
B Assigned Users
4 [ Active Directory Domains A Search
4
iemoted| & Create New Group
aw from Here
Group name: ‘Management ‘
Rz e licom o Cancel | -
@ Contacts Manager Support _ ,
e

<

Action: In progress..

Figure 4.3

Now you have your created groups under the contact list (Figure 4.4)
=

Contacts Manager - b
[@ File Action View Favorites Window Help HER
= zH =8
‘ ms Name Contacts Manager -
4 [=] Contact List1 (Al Contact Lists

View

4 E= Contact List
% Management

B Sales

[ Active Directory Domains
@ Contacts Manager Support

New Window from Here

|G Refresh
By Assigned Users |5 Export List...
i+ {4l Active Directory Domains H Hep
1 @ Contacts Manager Support

Figure 4.4

17
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4.3 Rename Contact List

To rename contact list, right-click on contact list then choose “Rename Contact List” (figure
5.1).

Contacts Manager
& File Action View Favorites Window Help

- o IEl
=]
«s | zsE ) BE

4 & Contacts Manager -
N =
4 (73 All Contact Lists ame Contact List1
4[] Contact Listt s Contact List 4 Rename Contact List
. B Contse|  Rename Contact List | view ,
B assign -
View v New Window fram H
» G Active Directo ) ew Window from Here
+ @ Contacts Man  New Window from Here % Delete
Delete = ExportList..
Export List... H Hep
Help
Rename Contact List

Figure 5.1

In “Rename Contact List" dialog box, enter the new name for the contact list (Figure 5.2)

B Contacts Manager - B
[@ File Action View Favorites Window Help

BEE
e=|2H = HE

] Console Root

Contact List1 Actions
4 ¥ Contacts Manager R
N -
4[] All Contact Lists 2me Contact List1
4 [ Contact List! T Contact List B/ Rename Contact List
1 T2 Contact List 3} Assigned Users View »
f5 Assigned Users New Window from Here
1+ Lgll Active Directory Domains
» @ Contacts Manager Support K Delete
@ Rename contact list (2 Export List..
[ Help
Nore

Action: In progress...

Figure 5.2

18
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A dialog box appears to tell you, it's recommended to refresh contact manager if you want to
refresh now, press “Yes” (Figure 5.3)

@

Contacts Manager = =
[@ File Action View Favorites Window Help MEER
o oo
4 %y Contacts Manager R
N tact -
a [ All Contact Lists ame %
4[5 New Contact List B Contact List @3 Rename Contact List
» B Contact List B Assigned Users View R
3 Assigned Users New Window from Here
i+ (4 Active Directory Domains
Delet:
& @ Contacts Manager Support ® R K Delete
= Bxport List..
Nate: it is recomended to refresh contacts manager H rep
Do you wart o refresh now?
Action: In progress...
=} Contacts Manager - O RS
[@ File Action View Favorites Window Help [==]=]
| H
4[& Contacts Manager
N tacts a
4 1 Al Contact Lists pme Contactshapagen
4 =] New Contact List [JAIll Contact Lists View »
& [= Contact List

B Assigned Users
i+ G Active Directory Demains
@ Contacts Manager Support

gl Active Directory Domains
@ Contacts Manager Support

New Window from Here
|G Refresh

| Export List...

H Hep

Figure 5.4
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4.4 Rename a Group

To rename a group, right-click on the target group then choose “Rename Group” (Figure 6.7).

& Contacts Manager - O
& File Action View Favorites Window Help [=1=]x]
e e EY
[ Console Roat

4 & Contacts Manager

4 [ Al Contact Lists
4 [=] New Contact List

Actions
Sales =

SIP URI

There are no items to show in this view. &/ Rename Group

4 = Contact List M Search
23 Management &) Refresh
3) Assigr Rename Group £ Create New Contact
1+ [ Active Directs Search View »
Contacts M
@ Contacts Mal Refresh New Window from Here
Create New Contact K Delete
View 3 |5 Export List...
New Window from Here H Hep 4
Delete
Export List...
Help 4

Rename group

Figure 6.1

In “Rename Group” dialog box, enter the new name for the group then press “Rename”
(Figure 6.2)

& Contacts Manager = B
File Action View Favorites Window Help E‘E‘E‘
e«szE =0

4 ¥ Contacts Manager

N SIP URI -
4 [ All Contact Lists ome Sales
4 & New Contact List There are no items to show in this view. £ Rensme Group
4 = Contact List S Search
3 Management .
Refresh
0 Sales ?
B Assigned Users © R GrEL ‘g Create New Contact
i+ Gl Active Directory Domains View 4
Contacts M Si L4
O ot New i
Aoply o assigned users K Delete
S Export List..
3 spues
Help »

Figure 6.2

20
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Now you have renamed the group successfully and a confirmation message appears (Figure

6.3)

Contacts Manager

File Action View Faverites Window Help

| 2E = BE

[ Console Root
a4 7 Contacts Manager

a [ All Contact Lists
4 [=] New Contact List
4 = Contact List
3 Management
3 Pl
B Assigned Users

» (il Active Directory Domains
i @ Contacts Manager Support

Mame

SIPURI

There are no items to show in this view.

Rename Group

The group has been renamed successfuly ...

Y

BEE

Actions

Figure 6.3

4.5 Create New Contact

To create a contact, right-click on the group then choose “Create New Contact” (Figure 7.1).

[@ File Action View Favorites Window Help

e 2H = 0E

[ Console Root
4 % Contacts Manager

N
4 [0 All Contact Lists ame
4 [2] Contact List1
2 = Contact List
Y Copy group to >
oy Meve group to 3
B s R Gro e
4[5 Conta —
4 B Co
@ Refresh
3 Ass|  Create New Contact
¢ Gl Active Dir — R
> @ Contacts
New Window from Here
Delete
Export List...
Help »

Contacts Manager

SIP URI

There are no items to show in this view.

Pre-Sales

g
-
y.
2
g

B X

Rename Group

Search

Refresh

Create New Contact
View

New Window from Here
Delete

Export List...

Help

- cEE

BEE

Actions

T

3 Copygroupte

3 Move group to

'£) Rename Group

£ Search

‘g Refresh

‘g Create New Contact
View
New Window from Here

K Delete

= Export List..

H rHep

Create New Contact

Figure 7.1
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In the Create New Contact dialog box, enter the contact's name and SIP URL,

"Create” Figure 7.2

&

& File Action Favorites

View

Window Help

] Console Root
4 ¥ Contacts Manager
. [ All Contact Lists
4 [=] Contact List1
4 E= Contact List
&
%3 Management
g Pre-Sales
B Assigned Users
4 [=] Contact List2
4 E= Contact List
o HR
B Assigned Users
1 [ Active Directory Domains
& @ Contacts Manager Support

Mame

Contacts Manager

‘

SIP URI

There are no items to show in this view.

(o) Create New Contact

MName John Bill
SIP URI J.Bil @est.com

Example: sip:someone @example.com
Eample: tel:311

e

[-[&]x]

Figure 7.2

IT

B Ve e

£
£

Copy group to

Move group to

Rename Group

Search

Refresh

Create New Contact
View

New Window from Here
Delete

Export List...

Help

Be sure to add “SIP:" before the SIP URL of the added contact (figure 7.3)

& File  Action

View  Favorites

1 Conscle Root
4 ¥ Contacts Manager
a [] All Contact Lists
a Contact List1
4 = Contact List
&7
@ Management
@ Pre-Sales
B Assigned Users
a [Z] Contact List2
4 E= Contact List
T HR
B Assigned Users
» [l Active Directory Domains
@ Contacts Manager Support

Window  Help
MName
<

Contacts Manager

SIP URI

There are no items to show in this view.

(54 Create New Contact

John Bil
sip :John Bil @test.com

Example: sip someone @example.com
Example: tel:911

Name

SIP URI

- O

[==]]

%l

B X

Figure 7.3

Copy group to

Move group to

Rename Group

Search

Refresh

Create New Contact
View

MNew Window from Here
Delete

Export List...

Help

then press
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=} Contacts Manager - bR
& Fille Action View Favorites Window Help HEER
=+ aE =8
[] Console Root T Actions
a4 ¥y Contacts Manager N
4 [0 All Contact Lists Heme SIP URl L
7 (= Contact List1 3 John Bill sipiJohnBill @test.com 3 Copygroupte »
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Figure 7.4

Now you have created a contact and you can find

4.6 Copy Group

it in the group list (Figure 7.4)

To copy a group, right-click on the group then choose “Copy group to”, and then choose the

targeted group name (Figure 8.1)
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Note: Copying group will keep the original group, just copying it to the targeted contact list
and a confirmation message appears. (Figure 8.2).
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To move a group, right-click on the group then choose “Move group to”, and then choose the
targeted group name (Figure 9.1).
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A dialog box appears to ask you “Are you sure you want to move (group name)?” press “Yes"

(Figure 9.2)
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Figure 9.2

Now you have moved a group and you can find it in the new contact list (Figure 9.3)
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4.8 Adding Contacts to a Group

To add contacts in (specific group), right-click on any contact(s) then, select “Add User to
Contact List” and select the contact list and choose the group you would like to add the

contacts to (Figure 11.1).
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Figure 111

Now you have added a contact or multiple contacts to a specific group and a confirmation
message with the contacts addresses appears (Figure 11.2)
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4.9 Adding Contacts to a New Group
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Figure 12.1

Right-click on any contact or select multiple contacts, then select “Add User to Contact List”
after that, select contact list and choose the “Create New Group” option (Figure 12.1).

4.9 Adding Distribution Group

To add distribution group as a group in the contact list, right-click on “distribution
group” and choose “"Add distribution group to contact list”, then choose contact list
name (Figure 13.7)
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Figure 13.1

5 Assigning Contact List

5.1 Adding Users in “Assigned Users”

To add users in "Assigned Users”, right-click on contact(s), choose "Assign User to Contact List”
and choose the contact list that you would like to add users (Figure 13.1).
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Figure 13.2

Now you have assigned your contact list successfully and a confirmation message with the
contacts addresses appears, Press Ok (Figure 13.2)
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Now you can see the assigned contact in the assigned users list (Figure 13.3).
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Note: You can assign one user to one or more contact list.
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6 Populating Contact List

6.1 Populating a contact list to single user:

To apply the contact list to a user, right-click on a contact and choose “Populate Contact List”
(Figure 14.1)
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Figure 14.1

A dialog box appears to confirm assigning the contact list to selected user, press “Yes”
(Figure 14.2)
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Figure 14.2
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Now you have populated a contact list to selected user successfully and a confirmation

Figure 14.3

message with the contacts addresses appears (Figure 14.3)

6.2 Populating a contact list to all assigned users

To apply a contact list of all assigned users at the same time, right-click on “Assign Contact
List" and choose “Populate Contact List” (Figure 15.1).

Contacts Manager

[@ File Action View Favorites Window Help

- o
==l

«s | pEE BE

] Console Root Assigned Users 1 Users
4 ¥ Contacts Manager - R
ine
4 [ All Contact Lists
4 [=] Contact List1 £ Donita sip:donita.south@test.com
4 = Contact List
3 Management
2 Sales
[A550H | Populate Contact List
a [ Active Direct; - -
2 test.com Wipe Contact List
o am Search
A ot s Refresh.
O gesa -
P owso View v
@ Contacts Man New Window from Here
Export List...
Help
< < >

| Actions
|Assignedusers  ~
3 Populste Contact List
3 Wipe Contact List
 Search
& Refresh
View »

New Window from Here
5h Export List..
H Hep
|Donita
Remove User
Populate Contact List
Wipe Contact List
B Image 3
H Hep

AssignedUser contact list to the users

Figure 15.1
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A dialog box appears to confirm populating the contact list to all its assigned users , press
"Yes” (Figure 15.2).
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7/ Updating Contact List

7.1 Wiping User's Contact list

To wipe a user’s contact list from assigned users, click on assigned user right-click on a contact

and choose "Wipe Contact List” now the user’s contact list will be wiped and the user will not
be removed (Figure 16.1).
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Figure 16.1

A dialog box appears to confirm wiping all contacts from the selected user, press "Yes”
(Figure 16.2).
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Contacts Manager will remove groups and contacts that are existing in the current contact list.
By Checking “Including all contacts added by the user(s)” all groups, contacts and manually

added groups and contacts will be removed from assigned user.

7.2 Remove user from assigned users

Right-click on the user then, select "Remove User” (Figure 17.1).
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Figure 17.1

A dialog box appears to confirm removing user (s) from assigned user (s) , press “Yes”
(Figure 17.2).

34



Contacts Manager V 4.0 - User Manual

& File Action View Favorites Window Help =0
e xE =B
= conmitom —

4 & Contacts Manager

N, sip L Depe | Assigned -
4 O All Contact Lists Jame ine SF igned Users
4 [=] Contact List1 £ donita sip:donita.south@test.com m 3 Populste Contact List
4 E= Contact List 3 Wipe Contact List
% :J\anagemant o Search
ales
B Assigned Users &2 Refresh
a U3 Active Directory Domains View »
D test,
¢ teheom New Window from Here
ye
- : [ Export List..
D
& Help
& Srecftoee & Confirm = &
1 @ Contacts Manager Support donita -

Do you want to remove useris) from assigned user(s)?
Remove User
] Wipe contact list of this useris)

Populate Contact List
Wipe Contact List
& Image >
Help

Figure 17.2

Note: Contacts Manager will remove assigned user from contacts manager only.

By checking "Wipe contact list of the user(s)” assigned user will be removed and wipe all his
groups and contacts

7.3 Wipe all users

To wipe all users, right-click on “Assigned Users” then, choose “Wipe Contact List” (Figure 18.1).
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7.4 Add new user to an existing contact list

When new employee join your company you can easily get him/her involved very fast to
your communication community. To add new user load “active directory” >> choose the
new user name by filtering active directory as we mentioned before. Right-click and
choose “Add User to Contact List". Choose Contact List name then choose the Group
Name.
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8 Contact List Features

8.1 Export Contact List

To export contact list, right-click on contact list then choose “Export Contact List” (Figure 22.1).
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Figure 22.1
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Browse to select a location then click “Save” (Figure 22.2)
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Figure 22.2

A confirmation message appears to confirm that “Export has been successfully” (Figure 22.3).
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8.2 Import Contact List

To import contact list, right-click on contact list then choose “Import Contact List” (Figure 23.1)
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Figure 23.1

Browse to select a contact list file then click “Open” (Figure 23.2)
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A confirmation message appears to confirm that “File has been imported successfully” (Figure

23.3).
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8.3 Taking Backup

To make a back-up from the contact list and the group you have created, right-click on “All

Contact List" then, choose “Back-up” and save it to your machine (Figure 24.1 & 24.2) .
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Figure 23.3
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Figure 24.2

A confirmation message appears to confirm that your backup have been taken successfully
(Figure 24.3)
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8.4 Restore the backup

To restore backup, right-click on all contact lists, then choose “Restore” (Figure 25.1).
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Figure 25.1

Choose the save backup file from your machine (Figure 25.2).
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Figure 25.2
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9 License Key Limitations

Trial Lite Standard Enterprise | Ultimate

Feature

Version Edition Edition Edition Edition

Maximum Number of assigned users 15 50 150 1000 Unlimited
Number of different contact lists 3 1 3 10 Unlimited
Add federated/external contacts v Vv v v v
Child domains support v v v Vv Vv
View user's current contacts list v Vv v v v
Lync Support v v v v v
Backup & Restore users contact list v v v v v
(D))G;agic update groups contact from AD J J J J J
Manage all user AD images v v v v v
Limited time in trial version. 14 days

# US and Canada: +18882667668

UK and Europe: +442034554119
Middle East & Africa:
+20502528897 ﬁ

WWW.vytru.com
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